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 THE INTERNET 

 

The Internet 

 

Many people use the terms Internet and World Wide Web interchangeably, but in fact 

the two terms are not synonymous.  The Internet and the Web are two separate but 

related things. 

 

The Internet, short for ‘International networking,’ consists of thousands of computer 

networks that connect millions of computers around the world. The Internet refers to 

the hardware and software that provides different communications services between 

computer networks. The Internet is also referred to as the ‘Net’, ‘Information 

Superhighway’ and ‘cyberspace’.  

 

 

 

World Wide Web 

 

The World Wide Web (WWW, W3 or the ‘Web’) is a way of accessing information over 

the Internet. It is an information-sharing model that is built on top of the Internet. 

 

The Web is just one of the ways that information can be disseminated over the 

Internet. The Internet (not the Web), is also used for electronic mail, file transfer 

protocol, Usenet newsgroups and instant messaging. So the Web is just a one part of 

the Internet.  

 

The Web consists of the text and pictures that you view on your computer. It 

encompasses all the Internet screens that appear on your computer. Over the years, 

these screens have evolved from heavily based text screens to graphical screens with 

pictures, sounds and video files. Such displays are commonly referred to as Web 

pages. 

 

 

 

Internet Service Provider, Uniform Resource Locator & Hyperlinks 

 

The Internet Service Provider (ISP) is a company that provides users with Internet 

connection services. ISPs provide home users with an Internet Account consisting of a 

username and a password. Users having the appropriate hardware and software will 

use the Internet Account to access the services available on the Internet. 

ISPs may charge a monthly subscription fee or a pay-per-use fee for use of the 

Internet Account. 

 

 

The Uniform Resource Locator (URL) is a standard address that tells your browser how 

to locate a file or other resource on the Web. This is also known as an Internet 

address or Web address. Every Web page is assigned an address e.g: 

http://www.skola.edu.mt  

 

 

http://www.skola.edu.mt/
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The URL contains all the useful information about the site that you are looking for.  

From the URL it is possible to know what type of organisation has put up the site, and 

also an indication of where the organisation is based. 

 

The URL of a Web page is made up of 3 distinct components: 

 

 

 

 

 

 

 

 

 

 
 

1. Service Protocol – Thousands of computers on Internet communicate with 

each other by sending packets of data back and forth. The diversity and 

multitude of computers on Internet dictate a standard procedure or protocol 

(set of rules) for the reading of Web pages. http:// is the language used by 

the web browser to request Web pages from a Web server.  

 

2. Domain Name – This identifies the name of the organisation where the 

information is stored. ‘mt’ indicates that the web site is registered IN Malta. 

‘edu’ shows that skola is an educational website.  

 

The following table shows some geographical domains: 

Domain Area Domain Area 

at Austria fr France 

au Australia gr Greece 

ca Canada ie Ireland 

ch Switzerland jp Japan 

de Germany mt Malta 

dk Denmark nz New Zealand 

it Italy uk United Kingdom 

 

The following table shows the types of organisations that may be found on 

Internet: 

 

Organisation Meaning 

com Commercial organisation 

edu/ac Educational institution 

gov Government body or department 

int International organisation (e.g. NATO) 

net Networking organisation 

org Non-profit making organisation (unions or charities) 

 

3. Folder & Filename (the File Path) - This shows the location of the Web page 

on the Internet server and the name of the document that is being requested. 

The file ‘ecdl’ ends with the extension ‘.html’ – short for hypertext markup 

language. 

http://www.skola.edu.mt/courses/ecdl.html 

Service Protocol 

Domain Name 

Folder on Server 

Filename 
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Some examples of URLs include: 

Ministry of Education http://www.education.gov.mt/ 

University of Malta http://www.um.edu.mt 

Government of Malta http://www.gov.mt 

NATO http://www.nato.int 

 

 

Web page – is the basic unit of the WWW. Web pages are hypermedia documents or 

screen displays containing all sorts of data ranging from text files and sound (audio) 

files to graphic images and any other sort of data stored in a computer file.  

 

Unlike regular documents, Web pages contain coloured text and graphics, which can 

link to other Web pages. 

 

For example, a Web page about Malta may contain the following coloured text - 

‘Beaches’. When you position the pointer over this text, the pointer changes to a 

pointing finger. Clicking the mouse over this text will take you to another web page 

displaying information and small pictures (called thumbnails) of popular beaches in 

Malta. When you click on a thumbnail you will be taken to another Web page 

displaying an enlarged view of the small picture. The beaches page may also contain 

the following coloured text ‘Transport in Malta’. Clicking the mouse over this text will 

take you to a Web page with information about transport in Malta.  

 

As you move from one Web page to the next, you may be jumping from one computer 

to another on the Internet. The coloured text and graphics which take you from one 

Web page to the next are known as hyperlinks. 

 
Hyperlinks are text or images available on Web pages which make connections to: 

 other sections on the same Web page. 

 a different Web page. 

 

Hyperlinks may be used to download files or launch an application, video or sound. 

 

 

 

Web Browsers 

 

The Web browser is a program used to locate and display Web pages. The three most 

popular browsers are Microsoft Internet Explorer, Mozilla Firefox and Google Chrome. 

These are available (can be downloaded) for free from Internet. Both of these are 

graphical browsers, which mean that they can display graphics as well as text. In 

addition, these can present multimedia information, including sound and video, though 

they may require plug-ins for some formats. 

 

The Web server is a computer connected to the Internet that makes Web pages 

available to other computers.  Web servers store and deliver files over the Internet in 

response to requests from web browsers. Any computer can be turned into a Web 

server by installing server software and connecting the machine to the Internet. 

 

 

http://www.um.edu.mt/
http://www.gov.mt/
http://www.nato.int/
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Search Engines 

 

If you do not know the URL of a Web page, you can still search for it using the search 

engines available on Internet. A search engine is a program that locates Web sites via 

searches for keywords and phrases. 

 

Typically, a search engines use a program known as a spider to fetch as many Web 

pages as possible. Another program known as indexer, then reads these documents 

and creates an index based on the words contained in each document. Therefore 

search engines do not search the WWW in real time. Each search engine maintains a 

database of information accumulated from the WWW. 

 

When you use a search engine and submit a query, the database is searched to yield 

Web pages that fit the search criteria. These are returned as a list of ‘hits’, rank 

ordered according to criteria applied by the search engine.  Different search engines 

maintain different databases of information and apply different criteria to rank order 

the list of potential sites. 

 

There are several search engines on the Internet including: 

Search Engine URL 

Google http://www.google.com  

Yahoo http://www.yahoo.com  

Ask http://www.ask.com 

Bing http://www.bing.com  

 

Most search engine sites contain sub-headings called directory indexes to facilitate the 

location of information on Internet. Directory indexes are used as a starting point for a 

search, refining the search criteria at each step of the way. 

 

 

 

Really Simple Syndication (RSS) Feed 

 

Many websites such as news sites (e.g. BBC and CNN) contain information that 

changes frequently. To keep track of the changes in news sites: 

 

 You open your Internet browser and visit these sites to check for updates. 

Normally you will add the web addresses of these sites to the browser 

favourites/bookmarks. 

 Alternatively you can subscribe to Really Simple Syndication (RSS) Feeds. The 

news sites will automatically send information to your browser when they are 

updated. You will need to visit a single website that receives all updates or 

feeds from different news sites. This website will contain a list of headlines 

and a small amount of text with a link to the full news story. This lets you 

quickly browse the list of new content without visiting each site. 

 

Really Simple Syndication (RSS) is technology you can use to have information sent to 

you, rather than having to go look for it. Many websites offer RSS as a way to have 

headlines delivered to you. 

 

http://www.google.com/
http://www.yahoo.com/
http://www.ask.com/
http://www.bing.com/
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To use RSS, you need a program known as a reader that enables you to read all posts 

in one place. The latest versions of Internet Explorer and Firefox browsers come with 

built-in RSS support.  

 

If you are on a website that has an RSS feed, the browser will usually 

recognize this and put the RSS icon on the tab bar in Internet Explorer. 

Clicking on the RSS logo will take you to the web feed where you can subscribe to it 

through Internet Explorer. 

 

 

 

Podcasts 

 

A podcast is an audio or video file available on the Internet for you to listen to and/or 

watch. A podcast can also refer to a series of these audio or video files (similar to how 

a TV or radio show can be a series of shows or just one show). When using the word 

podcast, most people refer to the entire series and not just one audio or video file. 

 

Podcast is made up of two words: 

 

 POD - You can either listen to a podcast on your computer or transfer it to 

your portable audio (e.g. MP3 player) or video device, which means that file is 

Portable, and it’s On-Demand because you can listen to or watch it when you 

want. 

 

 CAST - the file is sent out to you over the Internet, in the way a broadcast 

comes to you over the radio or TV airwaves. But instead of using a radio or 

TV, with podcasts you use a computer connected to the Internet, and on that 

computer you have a program that allows you to subscribe to, manage, and 

listen to or watch your favourite podcasts. 

 

Podcasting lets you automatically receive the latest 

audio/video shows from websites that you subscribe to as 

soon as these are available. You can subscribe to receive a 

podcast, rather like you might subscribe to a magazine and 

get it delivered each week.  
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In order to subscribe for a podcast, you need an Internet connection and podcast 

software which is usually available free of charge e.g. e.g. iTunes or Winamp. To 

subscribe to podcasts, locate the relevant button on the website. Each time you 

connect to Internet the podcast software will automatically download any new 

available podcasts to your computer.  

 

 

 

Secure Web Sites 

 

A secure (protected) Web site is a site that can only display its content if the user 

types in a username and a password. Many organisations restrict access to sections of 

their Web sites.  

 

The URL of a secure website starts with “https://” not “http://”. The browser will also 

show the padlock: 

 

 
 

When users try to access secure web sites, the browser prompts for a username and a 

password. The Web sites will be displayed if the correct username and password are 

entered. 

 

 

 

Digital Certificates 

Internet users are often concerned about online purchases. Normally payments for 

online purchases are made by a credit-card. Here are some important facts that you 

should know before submitting your credit number: 

 

 Information travelling between your computer and a server can be routed 

through many computer systems. 

 

 Any one of these computer systems can capture and misuse your information. 

Each of these computers can eavesdrop and make copies of your information. 

 

 An intermediary computer could even deceive you and exchange information 

with you by representing itself as your intended destination. 

 

If you decide to shop or do banking on the Internet, protect yourself by dealing with 

secure sites. Browsers display security warnings when you are about to enter a secure 

site. You can tell when you have a secure connection by looking at the URL. Secure 

sites have URLs starting with “https:” not “http://”. 

 

A secure Web site has a digital certificate confirming that it is secure and genuine. It 

ensures that no other Web site can assume the identity of the original secure site. 

When you are sending personal information over the Internet, you should check the 

certificate of the Web site you are using to ensure that it will protect your personally 

identifiable information. 

 

Digital certificates are issued by a certificate authority. When you visit a secure Web 

site, the site automatically sends you its digital certificate. Digital certificates are used 

by organisations involved in online monetary transactions. The certificates ensure that 

credit card details will not be intercepted as these travel from the buyer’s computer to 
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the web server. Digital certificates can be viewed by double-clicking on the padlock 

icon in the Web browser. 

 

 

 

Encryption 

 

Encryption is the translation of data into a secret code. A secret key or password is 

required to translate (decrypt) the secret code back to readable data. Encryption is 

used to safeguard confidential data as this as being transmitted over the Internet. 

 

Public-key encryption is one type of computer encryption system. This uses a public 

key known to everyone and a private or secret key known only to the recipient of the 

message. When John wants to send a secure message to Jane, he uses Jane’s public 

key to encrypt the message. Jane then uses her private key to decrypt it. 

 

An important element to the public key system is that the public and private keys are 

related in such a way that only the public key can be used to encrypt messages and 

only the corresponding private key can be used to decrypt them. Moreover, it is 

virtually impossible to deduce the private key if you know the public key.  Public-key 

systems, such as Pretty Good Privacy (PGP), are becoming popular for transmitting 

information via the Internet. They are extremely secure and relatively simple to use. 

The only difficulty with public-key systems is that you need to know the recipient's 

public key to encrypt a message for him or her. 

 

 

 

Malware 

 

Malware (malicious software) is a program designed to secretly enter and damage a 

computer system. Malware includes: 

 

 A computer virus is a piece of program designed and written to make 

additional copies of itself and spread from location to location, typically 

without user knowledge or permission. Viruses are written by programmers 

with malicious intent to annoy computer users. 

 

 Worms are similar to viruses in that they make copies of themselves, but 

differ in that they need not attach to particular files or sectors at all. Once a 

worm is executed, it seeks other systems - rather than parts of systems - to 

infect, then copy its code to them. Typically worms slow down computer 

systems. 

 

 Trojan horses secretly place illegal, destructive instructions in the middle of a 

computer program. Once the program is run, the Trojan horse becomes 

active. Trojans do not replicate themselves like other viruses. 

 

 Spyware is a program that secretly installs itself on computers and collects 

information about users without their knowledge. Spyware programs can 

collect various types of personal information, such as Internet surfing habits 

and sites that have been visited. They can also interfere with user control of 

the computer in other ways, such as installing additional software and 

redirecting Web browser activity. Spyware is known to change computer 

settings, resulting in slow connection speeds, different home pages, and/or 

loss of Internet or functionality of other programs. 

 

http://en.wikipedia.org/wiki/Web_browser
http://en.wikipedia.org/wiki/Internet
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Two sources of viral infections are: 

 Sharing infected files over the intranet i.e. the internal computer network of 

an organisation. 

 Downloading infected files from Internet sites. 

 

You should be careful with program or file downloads from the Web. Files available on 

bulletin boards or public newsgroups may be infected. Software updates e.g. drivers, 

multimedia players, should be downloaded from the manufacturer's official website. It 

is important to update your anti-virus program to prevent against malware. 

 

 

 

Firewall 
 

A firewall is a system designed to prevent unauthorised access to your computer 

system when connected to Internet. A firewall is simply a program or hardware device 

that filters information coming through the Internet connection into your private 

network or computer system. If an incoming packet of information is flagged by the 

filters, it is not allowed through. Many users having always-on connections (such as 

ADSL or cable) are encouraged to install personal firewalls (software) that protects 

their system from intruders. 
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 USING THE BROWSER 

 

Opening & Closing the Web Browser 

 

As indicated earlier the Web browser is a program used to locate and display Web 

pages. The three most popular browsers are Microsoft Internet Explorer, Mozilla 

Firefox and Google Chrome. The Web browser used during this course is MS Internet 

Explorer 9. 

 
To start MS Internet Explorer: 

1. Click Start button. 

2. Click All Programs. 

3. Click Internet Explorer. The following screen will be displayed: 

 

Note that: 

 You may also open MS Internet Explorer by clicking Internet 

Explorer icon in the Windows task bar. 

 When you start MS Internet Explorer, this will display a specific Web page. 

The first page displayed when you start up your browser is called the home 

page. 

 

 

 
 

 

To close the web browser, click Close button. 
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Entering URLs 

 

To enter a URL: 

1. Type the URL in the address field e.g. http://www.google.com.mt  

 

 
 

2. Press ENTER key. 

 

 

 

Displaying Web Pages 

 

Web pages may contain text, images and icons, 

referred to as hyperlinks that may link to other:  

 parts of the same Web page. 

 Web pages within the same website. 

 Websites. 

 

Text that links to other areas in the same Web page 

or different Web pages is usually underlined or/and 

coloured differently from the other text in the page. 

You can open a hyperlink and display the Web page in 

a new browser window: 

 

To display a Web page in a new separate browser 

window: 

1. Position the pointer on a hyperlink. 

2. Right-click the mouse. This will display a pop-

up menu. 

3. Click Open in new window.  

 

 

Note that: 

 You can also open a hyperlink and display the Web page in a new browser 

window by pressing SHIFT key whilst clicking on the link. 

 Your screen will display two browser windows, one containing the first Web 

page and the second containing the second Web page. 

 Typically you can switch between different browser windows by clicking the 

appropriate browser window button on the task bar. 

 

 
To display a Web page in a new tab: 

1. Repeat steps 1-2 as above. 

2. Click Open in new tab. 

 

Note that: 

 Your screen will display one browser window with two web pages in separate 

tab panes. Tabs enable you to switch between web pages within the same 
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browser window. There are some features associated with tab browsing such 

as bookmarking all web pages   

 

 
 

 

 

Stopping Web Pages from Downloading 

 

The downloading of some Web pages from Web servers to your computer may take 

considerable time. There may be several reasons for this: 

 

1. Web pages that are heavy loaded with images, sounds and movies are larger 

in terms of memory compared to text based Web pages. Accordingly these 

pages take considerable time to transmit from Web servers to your computer. 

2. The Web server may be slow. 

3. The modem and link to the Web server may be slow. 

 

You can stop a transfer whenever the loading process takes longer than 

expected by clicking the Stop button in the web page address 

 

 

 

Refreshing Web Pages 

 

Sometimes the content of a Web page (news page) may be updated during your 

online session. Your browser downloads the page once but it will not automatically 

reload the page when this has been changed. The refresh facility forces the browser to 

download the latest version of the page.  

 

To reload a Web page, click Refresh button.  

 

 

 

Using Help 

 
To use the available Help functions in Internet Explorer: 

1. Press F1 key. The Windows Help and Support window will be displayed. 

2. In the Search Help field, type in the keyword to find e.g. cookies. 

3. Click the topic to display. Help text will. 

4. Close the help window. 

 

 

Tab panes 
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Setting the Browser Home Page 

 

Your home page is displayed each time you start Internet Explorer or when you click 

Home button.  

 

You can set the browser’s home page as follows:  

1. Navigate to the webpage you want to set as the home page. 

2. Click the Tools button. 

3. Click Internet options. The Internet Options dialog box is displayed. 
4. In the General tab, do one of the following: 

To set the current webpage as the home page, click Use current.  
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To reset the home page, click Use default.  

To set a blank home page, click Use blank.  

 

5. Click OK. 

 

 

 

Deleting the Browsing History 

 

MS Internet Explorer automatically saves previously visited Web pages in a list known 

as the history list. The history list contains shortcuts to pages you viewed during 

browsing sessions. The list allows you to quickly return to the pages you have recently 

visited. 

 
To access the history list and display previously visited Web pages: 

1. Click Favourites button. The Favourites pane appears along the left side 

of the browser window. 

2. Click the History tab. This contains links to Web sites and pages visited in the 

previous days and weeks. 

3. Click a week or day. 

4. Click a website folder to display individual pages. 

5. Click the Web page icon to display page. 
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To delete specific websites from the history list: 

1. Repeat steps 1-3 as above. 

2. Right-click the website folder to delete. 

3. Click Delete.  

 

 

To delete all browsing history:  

1. Click Tools button. 

2. Point to Safety. 

3. Click Delete Browsing History… The Delete Browsing History dialog box is 

displayed. 

4. Tick the History check box. 

5. Click Delete button. 

 

Note that: 

 Deleting your browsing history does not delete your list of favourites or 

subscribed feeds. 
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Allowing & Blocking Pop-ups 

 

A pop-up is a small web browser window that appears on top of the website you are 

viewing. Pop-up windows often open as soon as you visit a website and are usually 

created by advertisers. 

 

MS Internet Explorer has a Pop-up Blocker feature that lets you limit or block most 

pop-ups. You can choose the level of blocking you prefer, from blocking all pop-up 

windows to allowing the pop-ups that you want to see. When Pop-up Blocker is turned 

on, the Information bar displays a message saying "Pop-up blocked. To see this pop-

up or additional options click here." 

 

By default, the Pop-up Blocker is turned on in MS Internet Explorer. To turn the pop-

up blocker off: 

 

1. Click the Tools button. 

2. Click Internet options. The Internet options dialog box is displayed.  

3. Click the Privacy tab. 

4. In the Pop-up Blocker section, untick the Turn on Pop-up Blocker. 

5. Click OK button. 
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Note that: 

 To turn on the pop-up blocker again, repeat steps 1-3 as above and tick Turn 

on Pop-up Blocker and click OK button. 

 

 

 

Allowing & Blocking Cookies 

 

Cookies are text files that save information regarding particular websites. They may 

save information, shopping cart contents, or user preferences.  

 

When a Web browser requests a Web page from a Web server, the latter can store a 

piece of text on the user’s computer. The text is sent back to the server each time the 

browser requests a page from that server. 

 

The main purpose of cookies is to identify users and possibly prepare customised Web 

pages for them. When you enter a Web site using cookies, you may be asked to fill out 

a form providing such information as your name and interests. This information is 

packaged into a cookie and sent to your Web browser which stores it for later use. The 

next time you go to the same Web site, your browser will send the cookie to the Web 

server. The server can use this information to present you with custom Web pages. 

So, for example, instead of seeing just a generic welcome page you might see a 

welcome page with your name on it. 

 

Many websites require that you enable cookies in order for the website to be properly 

viewed. To enable cookies: 

1. Click Tools button. 

2. Click Internet Options. The Internet Options dialog box. 

3. Click the Privacy tab. 
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4. Set the slider to Medium. This should be enough to enable cookies.  

If you want to enable cookies for a particular site, click Sites button. In 

Address of website: field type the URL. Click Allow button to enable cookies 

for that site.  

 

5. Click OK button to close the Per Site Privacy Actions dialog box. 

6. Click OK button to close the Internet Options dialog box. 

 

 
To block cookies for a site: 

1. Repeat steps 1-4 as above. 

2. If you want to block cookies for a particular site, click Sites button. In 

Address of website: field type the URL. Click Block button.  

3. Repeat steps 5-6 as above. 
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Deleting Temporary Internet Files 

 

Cache is a special folder on the hard disk that stores Web pages accessed by your 

browser. The first time visit a Web page, your browser retrieves all content (text, 

images, audio etc.) and a copy of these will be stored on the hard disk. The next time 

you visit the same Web page, your browser checks if the last modified dates of the 

files on the Internet are newer than the ones stored or cached. If the dates are the 

same, your browser uses the files on your hard disk instead of downloading these 

again from the Web server. Thus the cache speeds up browsing of Web pages. The 

files stored in the cache are known as temporary Internet files. 

 

The temporary Internet files are never deleted unless the cache is full. To delete 

these: 

1. Click Tools button. 

2. Point to Safety. 

3. Click Delete Browsing History… The Delete Browsing History dialog box is 

displayed. 

4. Tick the Temporary Internet files check box. 

5. Click Delete button. 

 
 

 

 

Displaying & Hiding Toolbars 

 

By default Internet Explorer does not display toolbars. To display or hide built-in 

toolbars: 

1. Right-click anywhere in the tab bar. A short-cut menu will be displayed. 

2. Click the toolbar to display/hide. 
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Activating Hyperlinks 

As indicated earlier on, links or hyperlinks are words or pictures in a Web page that 

can connect to another Web page. Links are usually underlined or in a different colour 

than the regular text in the Web page. Another way to find out if a piece of text or 

picture is a link, by placing the cursor over it. If it is a link, the cursor will change to a 

pointing hand. 

 
To navigate a website: 

1. Position the mouse pointer over the hyperlink. The pointer will change into a 

pointing hand. Also the URL location of the link appears in the status message 

area at the bottom-left of the window. 

2. Click once on the highlighted text, image, or icon. This transfers page content 

from a server location to your computer.  

 

Note that: 

 Sometimes the page specified by a link may not be available. Such links are 

often referred to as dead links. The error window shown on the following page 

will be displayed. 

 By default, links you have previously visited (referred to as followed links) are 

shown in a different colour compared to links (or unfollowed links) that you 

have not visited. 

 

 
 

 

 

Navigating Backwards & Forwards 

 

You can navigate backwards and forwards between previously visited web pages: 

 
1. Click Back button or ALT+ keys to display the previous page in 

the history list. 

 
2. Click Forward button ALT+ keys to display the next page in the history list. 

This button is available only after you have used Back button or a history 

menu item.  
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Navigating to the Home Page 

 

You can navigate to the home page of MS Internet Explorer by clicking the 

Home button.  

 
Note that: 

 Alternatively you can press ALT+M keys to display the browser’s home page. 

 

 

 

Displaying Previously Visited URLs 

 

MS Internet Explorer offers several facilities to re-display previously visited Web 

pages.  

 

To display previously visited URLs using the address bar: 

 

1. Click the drop down arrow to the right of the address bar. A list of previously 

visited URLs will be displayed. 

 

 
 

2. Click the address of the Web page you wish to visit. 

 

 
 

MS Internet Explorer automatically saves previously visited Web pages in a list known 

as the history list. The history list contains shortcuts to pages you viewed during 

browsing sessions. The list allows you to quickly return to the pages you have recently 

visited. 

 
To access the history list and display previously visited Web pages: 

1. Click Favourites button. The Favourites pane appears along the left side 

of the browser window. 

2. Click the History tab. This contains links to Web sites and pages visited in the 

previous days and weeks. 

3. Click a week or day. 

4. Click a website folder to display individual pages. 

5. Click the Web page icon to display page. 
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Adding & Deleting Bookmarks 

 

The Bookmarks, referred to as favourites in MS Internet Explorer enable you to store 

the URLs of Web pages that you frequently visit. It is a list of URLs of frequently 

visited Web pages. Through the favourites list you can return to a Web page without 

having to remember and retype its URL. Once you add a URL to the favourite list, the 

item stays until you remove it or edit the list. 

 
To add a URL to your list of favourite Web pages: 

1. Go to the page that you want to add to your favourites list. 

2. Click Favourites button. A short-cut menu is displayed. 

3. Click Add to favourites button.  

 

The Add a Favourite dialog box is displayed. You can replace the default name 

of the Web page in the Name: field. 

 

4. Click Add button. 

 
Note that: 

 The title of the currently displayed Web page will be added to the Favourites 

list. The Favourites menu grows as you add Web pages. 

 

 
To delete a bookmark: 

1. Click Favourites button. The Favourites tab in the pane displaying the list of 

bookmarked Web pages appears. 

2. Right-click the web page to delete from the Favourites list. 

3. Click Delete in the shortcut menu.  

 

 

 

Displaying Bookmarked Web Pages 

 

To display a bookmarked web page: 

1. Click Favourites button. The Favourites tab in the pane displaying the list of 

bookmarked Web pages appears. 

2. Click the page to open. The browser will display the selected Web page. 
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Creating & Deleting Bookmark Folders 

 

As your list of favourite pages grows, you can organise them by moving them into 

folders. To create a folder in the favourites list: 

1. Click Favourites button. 

2. Click Add to favourites arrow. A drop-down menu is displayed.  

 

 
 

3. Click Organise favourites…. The Organize Favourites dialog box is 

displayed. 

4. Click New Folder button. A new folder icon is displayed in the list. 

5. Type a name for your folder e.g. ECDL Links. 

6. Press Enter key. 

7. Click Close button. 
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To delete a folder in the Favourites list: 

1. Repeat steps 1-3 as above. 

2. Select the name of the folder to delete. 

3. Click Delete… button. The Delete Folder dialog box is displayed. 

 

 
 

4. Click Yes button to confirm. 

 

 

 

Adding Web Pages to Bookmark Folders 

 

To add a Web page to a particular folder in the Favourites list: 

1. Go to the Web page that you want to add to your Favourites list. 

2. Click Favourites button. 

3. Click Add to favourites arrow. A drop-down menu is displayed.  

4. In the drop-down menu, click Add to favourites… again. The Add a 

Favourite dialog box is displayed. 

 

 
 

5. Click the drop-down arrow in the Create in: field. This will display the 

available Favourite folders. 

6. Click the folder where the web page will be added. 

7. Click Add button. 
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 USING THE WEB 

 

Completing Web-based Forms 

 

In recent years Web pages have become highly interactive. Nowadays, Web pages do 

not only display information. Users are purchasing goods and services through the 

Web. Users are applying for courses through the Web etc. 

 

Web-based forms are one way how users may interact with the Web. Online forms are 

the equivalent of printed forms. They are so convenient because users can complete 

and submit these forms quickly. 

 

Web based forms may contain: 

 Text fields - These are blank boxes where you type in textual information. 

 Menu fields - These provide you with a choice to make in the form of a menu 

that “appears” when you click on it. 

 Check boxes - These are used when you have a choice to make. You can 

choose as many check boxes as you want.  

 Radio buttons – These are also used when you have a choice to make. Unlike 

check boxes, you can only choose the one you want. They are circular. 

 Submit or Reset buttons - These allow you to clear your form (reset) or to 

submit your form. What happens to the data after you “submit” depends on 

how the Web page has been set up. 

 

 
 
To submit a web-based form: 

1. Complete the web-based form. 

2. Click the Submit button. 

 

To reset a web-based form, click the Reset button. 

Text Field 

Menu field 

Check 

Boxes 

Button 
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Selecting a Search Engine 

 

As indicated earlier, a search engine is a program that locates Web sites via searches 

for keywords and phrases. You can use different search engines e.g. Google, Bing, 

Yahoo, Chrome etc. 

 

To select a specific search engine: 

1. Type a word or phrase in the Address bar. 

2. Click the arrow in the address bar.  

 

 
 

3. Select a search provider icon at the bottom of the expanded Address bar e.g. 

Google. 

4. Press Enter key. 

 

 

 

Searching for Information 

 

It is possible to look for information using the search facility available on the search 

engine site. If you know exactly what you are looking for, type the word or phrase 

that best describes the subject, click on ‘search’ button, and wait for the search engine 

to come up with the results. 

 

In some cases the search engine would list thousands of web pages related to the 

subject you are searching for. This would make it next to impossible to go through all 

the Web pages on the list. The following hints might help you select the appropriate 

information from Internet: 

 

 Read the ‘hints’ and ‘help’ for each search engine - these will explain 

how the search tool works, and which commands can be used to attain more 

accurate results. 

 Use specific words instead of general ones – for example, searching for 

‘constructivist education’ will have more specific results than a search for 

‘education’. 

 Use quotes around words that are part of a phrase - if you want the 

words to be found in a specific order, it is important to enclose them in 

inverted commas.  Thus, if you want to find documents about Jean Piaget, 

type in ‘Jean Piaget’.  The former will produce a never-ending list of Web 

pages having either Jean or Piaget or both. 

 Use the ‘+’ (plus) for words that the search must contain – if you are 

looking for Italian cars, you should search for +Italian+cars, which, means 

that the documents retrieved will all have both the word ‘Italian’ and the 

word ‘cars’ in them. 



ECDL Syllabus 5 Courseware 

26 

 Use the ‘-‘ (minus) for words that the search must not contain – if you 

are looking for information about cars but these must not be Italian cars, you 

should search for +cars-Italian.  The results of this search would include a 

list of documents about cars with no mention of Italian cars. 

 Use Boolean operators AND, OR, AND NOT – These operators must 

appear in capital letters and with a space on each side. 

o AND – documents found must contain all words joined by this operator, 

for example italian AND cars would list all Web pages about Italian 

cars. 

o OR – documents found must contain at least one of the words joined by 

OR, for example butterfly OR caterpillar would list all Web pages 

containing either butterfly or caterpillar. 

o AND NOT – documents found cannot contain the word that follows AND 

NOT, for example English language AND NOT England would display 

of all Web pages containing English language and not England. 
 

 
 

 
To search for specific information: 

1. In the Search field: type the keywords. 

2. Press ENTER key. The search engine will locate occurrences of the text in its 

database of Web pages. 

3. Examine the search results. These are usually presented as a list of links to 

pages containing the text you requested. Click any link to display a Web page. 
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Searching Web Based Encyclopaedias & Dictionaries 

 

You can access many encyclopaedias e.g. Wikipedia and dictionaries e.g. 

Dictionary.com on Internet. The screens of encyclopaedias and dictionaries vary 

however all of them will have a search field where you can type keywords to search. 

 

To use Wikipedia: 

1. In the address bar type www.wikipedia.org. 

2. In the search field type the keyword e.g. ecdl. 

3. Click search button. 

 

 
 

 
To use Dictionary.com: 

1. In the address bar type www.dictionary.com. 

2. In the search field type the keyword e.g. flood. 

3. Click search button. 
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 WEB OUTPUTS 

 

Saving Web Pages 

 

MS Internet Explorer allows you to save Web pages as files on your computer. To save 

the Web page displayed on your screen: 

1. Click Tools button. A drop-down menu will be displayed. 

2. Point to File.  

3. Click Save As… The Save Webpage dialog box is displayed. 

4. Browse to the disk/folder where the page will be saved. 

5. In the File name: field, type a name for the page. 

6. In the Save as type: field, do one of the following: 

 

 
 

 To save all of the files needed to display this page, including graphics, 

frames, and style sheets, select Webpage, complete. This option saves 

each file in its original format.  

 To save all of the information needed to display this page in a single file, 

click Web Archive, single file. This option saves a snapshot of the 

current webpage. This option is available if you have installed Outlook.  

 To save just the current HTML page, click Webpage, HTML only. This 

option saves the information on the webpage, but it does not save the 

graphics, sounds, or other files.  

 To save just the text from the current webpage, click Text File. This 

option saves the information on the webpage in text format.  

 

7. Click Save button. 

 

 

You can also save a Web page without viewing it: 

1. Right-click the mouse on a link. 

2. Click Save target as… 

3. Repeat steps 3 to 7 as above. 

 

 

 

Downloading Files from a Web Page 

You can download text files, image files, sound files, video files, and software from a 

Web page as follows: 

1. Right-click the file to download.  

2. Click Save target as… The Save As dialog box will be displayed. 

3. Browse to the disk/folder where the file will be saved. 

4. Type the name of the File in the File name: field. 

5. Click Save button. 
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Note that: 

 Files downloaded from Web pages may be infected with a virus. It is 

important that you use anti-virus software to scan all files downloaded from 

the Web.  If the files are safe you can proceed with opening these. 

 

 
To save an image: 

1. Right-click the image. 

2. Click Save picture as…  The Save Picture dialog box will be displayed. 

3. Browse to the disk/folder where the file will be saved. 

4. Type the name of the File in the File name: field. 

5. Click Save button. 

 

 

 

Copying Text, Images & URLs 

 

You can copy text, images and URLs from a web page to documents. 

 

To copy text from a web page to a document: 

1. Select the text you want to copy. 

2. Right-click over the highlighted text. 

3. Click Copy.  

4. Paste the information into the document you are working on. 

 

 
To copy an image from a web page to a document: 

1. Right-click the image to copy 

2. Click Copy. 

3. Paste the image into the document you are working on. 

 

 
To copy a URL to a document: 

1. Right click the hyperlink text. 

2. Click Copy Shortcut. 

3. Paste the URL into the document you are working on. 

 

 

 

Preparing Web Pages for Printing 

 
You prepare a web page for printing: 

1. Click the Tools button. A drop-down menu will be displayed. 

2. Point to Print.  

3. Click Page setup… The Page Setup dialog box is displayed. 

4. In the Page Size: field, set the paper size e.g. A4. 

5. Set the orientation of the web page to Portrait or Landscape. 

6. Set the margins. 

7. Click OK button. 

 



ECDL Syllabus 5 Courseware 

30 

 
 

 

 

Previewing Web Pages 

 

When printing a Web page, MS Internet Explorer formats content according to the size 

of the printed page. The Print command rearranges the page layout (text is word-

wrapped and graphics are repositioned) to fit in the paper. 

 

To preview the appearance of a printed Web page: 

1. Click the Tools button. A drop-down menu will be displayed. 

2. Point to Print.  

3. Click Print preview… The Print Preview dialog box is displayed. 

4. Select the appropriate option. 

5. Click Close button to close the Print Preview screen. 

 

Option Button To do this 

Print 
 

Set printing options and print the page 

Portrait 
 

Print the page vertically (portrait orientation). 

Landscape 
 

Print the page horizontally (landscape 
orientation). 

Page Setup 
 

Change paper size, orientation, or margins, and 
add headers or footers. 

Turn headers or 
footers on or off 

 

Decide whether to print additional information 
(such as the date, website address, or page 
number) at the top or bottom of the page. 

View full width 

 

Zoom the webpage to the width of the preview 
screen. 

View full page 

 

Zoom the webpage to show the full webpage in 
the preview screen. 
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Option Button To do this 

Show multiple 
pages  

View multiple pages on the preview screen 

Change Print 
Size  

Stretch or shrink the page size to fill the printed 
page. 

Page number 

 

Type the number of the page you want 
displayed. 

First page 

 
Display the first page to be printed. 

Previous page 
 

Display the previous page to be printed. 

Next 
 

Display the next page to be printed. 

Last Page 
 

Display the last page to be printed. 

 

 
 

 

 

Printing 

 
You can also adjust the Page setup options before printing: 

1. Click the Tools button. A drop-down menu will be displayed. 

2. Point to Print.  

3. Click Print… The Print dialog box will be displayed. 

4. Select the appropriate options. 

5. Click Print button. 
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To print… Do this 

Entire Web page Tick the option All in the Page Range section. 

Specific page(s) Type the pages to print in the Pages: field. 

Selected text Tick the option Selection in the Page Range section.  

Number of copies Type in a number in the Number of copies: field. 
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 ELECTRONIC COMMUNICATION 

 

Electronic Mail 

 

Electronic mail or email is a way of sending electronic messages through the systems 

and networks that make up the Internet. Email is the most frequently used application 

on the Internet. This is because email has many advantages over other means of 

communication: 

 

 Email is very fast compared to normal the postal service. An email gets to any 

destination in a few minutes. 

 Email is cheaper compared to the normal postal service. It only requires an 

Internet connection. There is no need for envelopes and stamps. 

 

To send and receive email you will need an Internet connection and an email address. 

You may also need an email client (or program) with specific email addresses. 

 

 
You can obtain an email address from any of the following sources: 

 Typically the ISP which provides you with an Internet connection will also 

provide you with an email address. 

 Your school will provide you with an email address. It is important that you 

use such email for schoolwork. Such emails should not be used for personal 

communication or to forward jokes. 

 You can get a free email address from some Web sites e.g. Hotmail, Yahoo, 

Gmail etc. Email addresses derived from the Web are known as Web-based 

email accounts. Web-based accounts enable you to read and send email 

through a Web page i.e. from any location. You will not need to configure an 

email program on the Internet connected computer. However, most ISPs and 

organizations do offer facilities to check their email addresses through the 

Web. 

 

 

 

Structure of an Email Address 

 

Email addresses have a standard format made up of two parts separated by the @ 

symbol: 

1. The UserID or Username is a unique identification of a person on a particular 

server. 

 

2. The Host name or Domain name is the location at which the mail is sent. This 

refers to the mail server i.e. the computer where the recipient has a mailbox. 

 

 

 

 

 

 

john.borg@skola.gov.mt 

Username 

Domain 
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How does Email work? 

 

Every user with an email address has a mailbox that stores all incoming and outgoing 

mail. The mailbox is located on the mail server computer at the ISP.  This mail server 

computer is connected to Internet 24 hours a day. So, your incoming mail is delivered 

to your mailbox even while you have your computer switched off. Therefore, you need 

to check your mailbox to read your mail. You will need a mail program such as MS 

Outlook or Mozilla Thunderbird to read and send mail (unless you will be checking 

email on the Web).  

 

Therefore, you type a message on your computer using a mail client. You send the 

message when you connect to Internet. The email will be delivered to the electronic 

mailbox of the recipient (the person who receives your email) on a mail server 

computer. The recipient can check his or her mailbox and can download the electronic 

messages from the mail server to his/her computer. The recipient of your message 

can respond to you, forward the message to someone else, file the message in the 

computer, or just delete the message. 

 

It is important to understand that the recipients of your mail do not have to be 

present at their computer when you send mail to them. Your message travels to the 

destination mailbox quickly. But the person at the other end still has to check the 

mailbox to read your message. 

 

 

 

Short Message Service (SMS) 

 

Short Message Service (SMS) allows for short text messages to be sent from one cell 

phone to another cell phone or from the Web to another cell phone. SMS is also 

referred to as texting, sending text messages or text messaging. SMS text messaging 

is the most widely used data application in the world.  

 

 

 

Voice Over Internet Protocol (VoIP) 

 

Voice Over Internet Protocol (VoIP) – is an Internet service that enables you to 

communicate using voice with another person/s. The communication is real time. It is 

a telephone conversation over Internet. Sometimes this is referred to as Internet 

telephony or IP telephony. Many home users communicate with their friends and 

relatives through Internet telephony using a VoIP program, a microphone and 

speakers/headphones. There are no additional charges for these voice calls because 

these happen over the same Internet service used for Web browsing and e-mail. 

 

 

 

Instant Messaging (IM) 

 

Instant Messaging (IM) – is an Internet service that enables you to communicate 

using text with another person/s using an instant messaging program. The 

communication is real time – similar to a telephone conversation but using text 

instead of voice. A program known as instant messenger is used for text or chat 

communication. Typically, the instant messaging system alerts you whenever 

somebody on your private list is online. You can then initiate a chat session with that 
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particular individual. You can also use an instant messaging program to send files such 

as documents and pictures. 

 

Nowadays, programs such as Windows MSN (Messenger) and Skype are used as 

instant messengers and VoIP. Some users make use of web cam during IM or VoIP 

communications. 

 

 

 

Online Communities 

 

An online (virtual) community is a group of people that communicate with each other 

using Internet e.g. email, internet social network service or instant messages. They 

communicate for social, professional, educational or other purposes.  

 

Many individuals use social networking websites such as Hi5 or Facebook to keep in 

touch with their friends and seek ‘old’ friends. They set up an online profile, describing 

their interests, and add links to other profiles. Generally, users are able to post 

personal information, including photographs, videos etc. Some people join special 

interest groups on social networking sites. 

 

 

An Internet forum is also called a message board, discussion group, bulletin board or 

web forum. An Internet forum usually allows all members to make posts and start new 

topics. 

 

Before a prospective member joins an Internet forum and makes posts to others, s/he 

is usually required to register. The prospective member must usually agree to follow 

certain online rules, sometimes called netiquette. When a member is approved by the 

administrator or moderator of the Internet forum, the member usually chooses his or 

her own user name and password. Sometimes, a password is supplied.  

 

The separate conversations in an Internet forum are called threads. Threads are made 

up of member-written posts. Internet forum members can usually edit their own 

posts, start new topics, post in their choice of threads and edit their profile. A profile 

usually lists optional information about each forum member such as the city they are 

located in and their interests. 

 

An Internet forum administrator or monitor may also participate in the forum. A forum 

administrator can usually modify threads as well as move or delete threads if 

necessary. Administrators can also usually change software items in an Internet 

forum. Moderators often help the administrator and moderate Internet forum 

members to make sure the forum rules are being followed. 

 

 

Chat rooms are virtual spaces on Internet where individuals discuss topics in real time. 

Within a chat room, there may be a moderator who monitors the content of the 

conversation in order to prevent abuse.  

 

Social networking, Internet forums and chat rooms provide ways to learn, talk and 

socialize, however some users abuse these systems. Children and teens must be 

aware that they can meet irresponsible users and adults who use chat rooms 

anonymously. Children must report all bullying and harassment they may receive 

through chat rooms. Children and teens must never give their personal contact 

details, pictures etc unknown users. They must never meet a person that they have 

met through a chat room or any other social networking. If they agree to meet a 
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person, they must be accompanied by a parent or an adult family member. Parents 

need to be aware of who their children are talking to in chat rooms and social 

networking sites. 

 

 

Online computer games refer to any type of game that someone can play through the 

Internet or over a computer network. Most of the time, online gaming refers to video 

games played over the Internet, where multiple players are in different locations 

across the world. Online gaming also refers to gambling over the Internet, through an 

online casino. 

 

Online gaming is growing in popularity for a variety of reasons. Gamers can easily find 

opponents of a similar skill level when playing a game over the Internet. Players also 

can compete in multiplayer games, where many players play an ongoing game in a 

virtual world. Often times, participants can communicate with other gamers through 

text chat sessions during online gaming or, sometimes, players can actually speak to 

other players, using special audio hardware. Some online games charge a monthly fee 

for access to the video game software. 

 

 

Parents are encouraged to supervise closely what their children are doing on the 

computer. Software can be installed on computers to monitor the sites visited by 

children and teenagers. Parents are encouraged to agree with children on the duration 

of time that their children spend on the computer. 

 

 

 

Fraudulent & Unsolicited Email 

 

All email users must be able to distinguish between genuine, unsolicited and 

fraudulent messages. 

 

From time to time you may receive messages with promotional material about a 

product or service. You may not be interested in such messages which are often 

referred to as unsolicited mail or spam mail.  

 

Occasionally you may receive messages with information about fraudulent schemes 

such as pyramid selling or get rich quick schemes. It is important that you do not 

forward such emails and delete these from your mailbox. 

 

You may also receive messages which appear to be sent from a reputable institution 

such as a bank, a mobile company, an Internet Service Provider (ISP) asking for 

personal information such as name, surname, address, username, password, and 

credit card details. This is known as phishing. It is important that you do not forward 

such emails and delete these from your mailbox. 

 

 

 

Phishing Messages 

 

Phishing messages often direct you to enter details at a fake website whose look and 

feel are almost identical to the legitimate one. Reputable institutions/organisations 

never ask users to send their usernames, passwords, credit card details etc via email. 

It is therefore important to disregard these messages. If you are in doubt, phone the 

institution/organisation and inform them that you received a phishing message. 
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Computer Viruses & Emails 

 

Files attached to emails may contain viruses that may infect your computer system. 

Receiving an email with an infected file attachment does not infect your computer. You 

need to open the file for your system to be infected.  

 

It is important to treat all files attached to emails with caution. Use an updated 

antivirus program to scan these files before opening. Some file types particularly those 

carrying the extension .EXE, .COM, .PIF, .JS, .VBS, .SHS, .SCR, .DOT are potential 

viral infections. Double file extensions e.g. "readme.txt.vbs", should always be treated 

with suspicion. Just because an email appears to come from someone you trust, this 

does not mean the file is safe or that the supposed sender has anything to do with it.  

 

 

 

Digital Signatures 

 

A digital signature (not to be confused with a digital certificate) is basically a way to 

ensure that an electronic document (email, spreadsheet, text file, etc.) is authentic. 

Authentic means that you know who created the document and you know that it has 

not been altered in any way since that person created it. 

 

Digital signatures rely on certain types of encryption to ensure authentication. 

Encryption is the process of taking all the data that one computer is sending to 

another and encoding it into a form that only the other computer will be able to 

decode. Authentication is the process of verifying that information is coming from a 

trusted source. These two processes work hand in hand for digital signatures. 

 

 

 

Netiquette 

 

As with other forms of communication media, there are widely observed conventions, 

often known as ‘network etiquette’ or ‘netiquette’ - associated with email 

communication. Netiquette is a set of guidelines intended to promote effective, 

efficient and responsible communication between all email users. 

 

The following netiquette guidelines are derived from those in use at many locations on 

the Internet: 

 

 Use short meaningful descriptions in the subject field of all your messages. 

Messages without subject lines can confuse and frustrate the persons who 

receive these particularly if they receive a lot of mail. 

 

 Messages should be concise and to the point. Use short paragraphs with 

breaks in between. White space makes long text easier to read. 

 

 Be careful about the way you express yourself in a message, especially if you 

feel strongly about an issue. Never shoot off a quick response to some issue. 

Once you press the send button there is no way you can retrieve the message 

back. 

 

 Never type your messages in all uppercase letters. Capitalizing whole words 

that are not titles is the equivalent of shouting. Asterisks are usually used to 

add *emphasis* to a word. 
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 Acronyms (e.g. ASAP – as soon as possible) are often used in email 

messages. Avoid overuse of acronyms in your messages. Such messages can 

confuse and annoy readers that are not familiar with acronyms. 

 

 Ensure that your message is free of spelling and grammar errors before 

pressing the ‘send’ button. 

 

 It is unethical to forward a message without asking permission of the person 

who wrote the message.  

 

 Do not make changes to someone else's message and pass it on without 

making it clear where you have made the changes. 

 

 Do not initiate or forward chain letters and other unwanted email, known as 

‘spam’, to your friends.  

 

 Be careful with file attachments that you send along with your mail. Large 

files can completely fill the recipient’s mailbox making it impossible for 

him/her to receive any more messages. Seek permission from your recipients 

before actually sending large mail (>5Mb). Compression utility programs can 

be used to reduce the sizes of your attached files. 

 

 Some networks blocked the transmission of emails with particular files e.g. 

executable files and MS Access files. You may be able to send such files if 

these are compressed using compression utility programs. 
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 USING EMAIL 

 

Opening & Closing MS Outlook 

 

As indicated earlier, an email client is a program used to send and receive email. 

There are several email clients such as MS Outlook and Mozilla Thunderbird. The email 

program that you will use is MS Outlook 2010. 

 
To start MS Outlook: 

1. Click Start button. 

2. Select All Programs. 

3. Click Microsoft Office. 

4. Click Microsoft Outlook 2010. 

 

 
 

 
MS Outlook 2010 displays four vertical panes: 

 Navigation Pane (1) – has tools and information determined by the current 

selection. The Navigation Pane displays several tabs including Mail, Calendar, 

Contacts, Tasks, Notes, Folder List, Journal, and Shortcuts.  

 Message Pane (2) - contains all emails in the folder currently selected.  

 Reading Pane (3) - displays the content of the email currently selected, its 

basic header information (sender, recipients and subject) and any file 

attachments. 

 Calendar Pane (4) - displays appointments, events and meetings. 

 

 

To close MS Outlook, click Close button. 

 

 

1 

2 

3 

4 
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To open an email i.e. to view a message: 

1. In the Navigation pane click Inbox folder. The Message Pane will display the 

list of emails in the Inbox folder. 

2. In the Message pane, click the email to open. The Reading pane will display 

the message. 

 
Note that: 

 To view a message in a separate window, double click the email in the 

Message pane. 

 

 
 

 To view messages that you have sent, click Sent Items folder in the 

Navigation pane. 

 

 
To close an email: 

If you are viewing the email in a separate window, click the close button of the 

window. You will be returned to the previous MS Outlook screen. 

 

 
A typical email message includes: 

 Subject: a short meaningful description of the message 

 Date: when mail was sent 

 From: the sender’s address 

 To: the recipient’s address 

 Body of the message. 

 

The From: and To: lines contain addresses that are similar to the addresses you put 

on a paper envelope. The electronic postmaster is much stricter about the format of 

the address. All the spelling and punctuation must be correct, or the message will be 

sent right back to you from the electronic mailbox. 
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The Subject line is a convenient place to give a one-line description of your message. 

This description helps the person receiving your email to decide what your mail is all 

about.  

 

 

 

Creating New Email 

 
To create a new email: 

1. In the Home tab, click New E-mail button. The Untitled Message 

window will be displayed - here you will type the message to send. 

2. Type the email address of the person you want to send the message 

to in the To: field. If you want to send the same message to several 

people, press ENTER key after typing the first address and type another 

email address. 

 

 
 

An address in an address list can have one of the following recipient types: 

To: Primary recipients of your message. 

Cc: Carbon Copy, for secondary recipients i.e. the persons whom you decide to 

keep them informed.  

Bcc: Blind Carbon Copy, email addresses typed in this field are not visible. 

 

3. Type the subject of your message in the Subject: field.  

4. Click in the lower part of the window and type in the message. You 

can copy and paste text from other programs such as MS Word etc. 

5. Click Send button to send your message.  
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Note that: 

 By default, the email message sent is stored in the Sent Items folder. 

 To discard your message without sending it, just close the window. 

 

 

 

Inserting & Removing File Attachments 

 

Email messages do not only consist of simple text messages.  Depending upon the 

hardware and software, e-mail messages can contain embedded sound files, image 

files, video-clip files, executable files etc. These are collectively known as attached 

files. Attached files are files that are sent along with e-mail messages. 

 
You can attach files to an email message: 

1. In the Message tab, click Attach File button. The Insert File 

dialog box will be displayed. 

 

 
 

2. Browse to the disk/folder where the file (to be attached) is located. 

3. Click the file to attach. The name of the selected file will be displayed in the 

Attached: field. 

 

4. Click Insert button. 

 

To remove a file attachment: 

1. Click the name of the file in the Attached: field. 

2. Press Delete key. 
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Retrieving Messages 

 

Messages are stored in your mailbox on the mail server until you download them using 

your mail program. To retrieve messages, you need to connect to the Internet: 

 

1. Click Home tab.  

2. Click Send/Receive All Folders button. The program retrieves 

all mail in your mailbox.  

 

Note that: 

 By default, the Inbox folder stores all incoming mail. 

 

 

 

Saving Draft Emails 

 

Occasionally you may wish to save an email and continue working on it at a later time 

before sending this.  

 
To save a draft of an email: 

1. In MS Outlook, start typing an email.  

2. Click File tab. 

3. Click Save. 

 
Note that: 

 The email will be saved in the Drafts folder. 

 

 
When you are ready to continue working on the message: 

1. Click the Drafts folder in the navigation pane. 

2. Double-click on the message you want to work with from the list in the main 

view. 

 

 

 

Checking Email Spelling 

 
To check the spelling of an email: 

1. Click in the body of the email. 

2. Click the Review tab. 

3. In the Proofing group, click Spelling & Grammar button.  
4. Click the appropriate options (refer to the following table). 

5. Click OK button when MS Outlook displays a message that it has 

checked all text in the email. 

 

Option To Do This 

Not In 
Dictionary 

Displays a possible error, such as an incorrectly spelled word, a duplicate 
word, a grammar error, or incorrect capitalization.  Edit the text in this box to 

correct it, and then click Change, or click the correct word in the Suggestions 

box and then click Change. 
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Option To Do This 

Suggestions Lists a number of words close to the incorrectly spelled word.  Click the 
appropriate suggestion to choose it.  

Ignore Once Leaves the word unchanged and continues with the checking. The spell 

checker stops if the same word is encountered within the same email.  This 
button changes to Resume if you click in the document to edit the document.   

Ignore All Leaves the word unchanged and skips any occurrences of the same word 
within the entire email throughout the rest of the current MS Outlook session. 

Add to 
Dictionary 

Adds the word in the Not In Dictionary box to the custom dictionary. 

Change Replaces the incorrectly spelled word with the highlighted word/phrase in the 
Suggestions: box. When the selected error is a repeated word, this button 

changes to Delete so you can easily remove the second instance of the word. 

Change All Replaces all occurrences of the same incorrectly spelled word with the 
word/phrase in the Suggestions: box. 

Autocorrect Adds a word to the AutoCorrect list so that MS Outlook can correct any 
incorrect spelling of it automatically as you type. 

Options Displays a dialog box in which you can specify the rules that MS Outlook uses 
to check spelling and grammar. 

Undo Reverses the most recent spelling and grammar check actions, one at a time. 

 

 
 

 

 

Setting Message Priority 

 

When you send a new message, you can assign a priority to it, so the recipient could 

see if the message has a high or low priority setting. 

 

You can set the priority of a message: 

1. Click the Message tab. 

2. In the Tags group, click  

High Importance or Low Importance.  

 

  



 Module 7 

 45 

Note that: 

 Messages sent with a high priority setting will be delivered at the same speed 

as a message having a low priority setting. 

 To switch off priority repeat steps 1-2 as above. 

 

 

 

Replying to Emails 

 

When replying to a message the original message and the subject details of the 

message with the prefix RE:. The reply to the message can be typed above, below or 

in the body of the original message. 

 
To reply to a message: 

1. In the lnbox folder, select the message to reply to.  
2. Click the Home tab. 

3. In the Respond group:  

To reply to the sender, click Reply button.  

To reply to all recipients of the original email, click Reply All 

button. 

4. The RE: message form displays. Type a reply message. 

5. Click Send button. 

 

 

 

Forwarding Emails 

 

Once a mail message has been read it can be forwarded to other mail users. The 

sender's own comments can be added to the message before it is sent to other 

members. 

 

As with replying to messages, the subject of the original message is automatically 

entered in the Subject box with a prefix. In this case FW: indicating that the message 

is a forwarded message. 

 

When forwarding a message the original message with the address information is 

automatically entered in the Message area. 

 

To forward an email: 

1. In the lnbox folder, select the required message to forward. 

2. Click the Home tab. 

3. In the Respond group, click Forward button. The FW: message form 

displays.  
4. Click in the To: field and type the email addresses of the users to 

receive the forwarded message. 

5. If required, type a message in the Message area. 

6. Click Send button. 
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Saving & Opening File Attachments 

 

Messages carrying attachments display a paper-clip 

icon. When you read these messages, the name of the 

attached file will be displayed below attachments. 

 

It is important that you save the attached file on your computer and use updated 

antivirus software to scan if the file is infected. 
To save a file attachment: 

1. Click the email that has the file attachment. 

 

 
 

2. Click the attached file. 

3. In the Attachments tab, in the Action group, click Save As button. 

The Save Attachment dialog box is displayed. 

 

 

 
 

4. Browse to the disk/folder location where the attachment will be saved. 

5. Click Save button. 

 
Note that: 

 To open the attachment/s saved you will need a program that can open files 

of the same type as the attachment's file format. For example, if you want to 
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open a .DOCX file, make sure you have a program on your computer that can 

open .DOCX files. 

 

 

 

Previewing & Printing Messages 

 
You can preview a message before printing: 

1. Click File tab. 

2. Click Print. The BackStage View is displayed. The message will be displayed 

on the right. 

3. Click Print button.  

 

 
 

 

 

Replying With/out Original Message 

 

By default, when replying to a message, this will also contain the original message. To 

change this setting: 

 

1. Click File tab. 

2. Click Options. The Outlook Options dialog box is displayed. 

3. Click Mail. Scroll down to Replies and Forwards section. 

 

 
 

4. In the field When replying to a message, click  

Include original message text or 
Do not include original message. 

5. Click OK button.  
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Flagging Emails 

 

You can use flags to remind yourself to follow up an issue or to categorize messages in 

your Inbox. To flag a message: 

1. Click the message to flag.  

2. Click the Home tab. 

3. In the Tags group, click Follow Up. 

4. Click Flag Message. The subject of the message will 

display a coloured flag. 

 

 
 

 
To remove the flag mark from a message: 

1. Repeat steps 1-3 as above. 

2. Click Clear Flag. 

 

 

 

Identifying Read & Unread Emails 

 

When you receive emails, the Unread Mail folder will be bold. It will also display the 

number of unread messages within a bracket. 

 

Unread emails in the Message pane will display a closed envelope. Messages that you 

have already opened will display an open envelope. 
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You can also mark emails as read or unread: 

1. Choose the message in the Message pane. 

2. In the Home tab, in the Tags group, click Unread/Read button.  
 

 

 

Minimising & Restoring the Ribbon 

 
You can minimise the Ribbon i.e. the row of buttons below each tab: 

1. Right-click on one of the tabs e.g. the View tab. 

2. Click Minimise the Ribbon. This will hide the Ribbon, leaving only visible the 

Ribbon's tab headers. 

 
Note that: 

 Clicking on any of the tabs will now display the tab's commands, and hide the 

ribbon once you have clicked on a command. 

 

 
To restore the minimised Ribbon: 

1. Right-click on one of the tabs e.g. the View tab.  

2. Click Minimise the Ribbon. This will display the Ribbon. 

 

 

 

Using Help 

 
To use MS Outlook help: 

1. Click Help button. The Outlook Help window is displayed.  

 

 
 

2. Click one of the main topics e.g. ‘Getting started with Outlook’. This will 

display sub-topics. Click the sub-topic to display. 

You can type a keyword or question e.g. ‘address book’ in the search field. 

Click Search button. Click the topic to display. 
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3. Click Close button to close the Word Help window. 
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 EMAIL MANAGEMENT 

 

Searching Messages  

 

You can use the Instant Search tool in MS Outlook to search for a message by sender, 

subject or email content: 

1. In the Navigation, click the folder that you want to search. 

2. In the Instant Search box, type your search text e.g. sender’s name or 

subject or text in email messages. 

 

 
 

Items that contain the text that you typed are displayed in the Instant Search 

Results pane with the search text highlighted.  

To narrow your search, type more characters. 

To widen your search to include all folders, at the end of the search results, 

click Try searching again. 

 

3. Click the message to view. 

 

 
To search an e-mail specifically by sender: 

1. In the Navigation, click the folder that you want to search. 

2. Click the Instant Search box. 

3. In the Search tab, in the Refine group, click From.  

The Instant Search box will display from:(Sender Name) 

 

4. Replace the Sender Name with the name or email address of the sender. 

Items that contain the sender name are displayed in the Instant Search 

Results pane. 

5. Click the message to view. 

 

 
To search an email specifically by subject: 

1. In the Navigation, click the folder that you want to search. 

2. Click the Instant Search box. 
3. In the Search tab, in the Refine group, click Subject.  

The Instant Search box will display from:(keywords) 
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4. Replace the keywords with a word or phrase  

Items that contain subjects with the word or phrase are displayed in the 

Instant Search Results pane. 

5. Click the message to view. 

 

 

 

Sorting Messages 

 

You can sort emails by name, by date or by size: 

1. Click View tab. 

2. In the Arrangement group,  

Click From to sort the emails by name. 

Click Date to sort emails by date starting from the most recent one. 

Click Size to sort the emails by size. 

 

 

 

 

Creating & Deleting Email Folders 

 

You can create folders in MS Outlook to organise the messages that you want to save 

for future reference. For example you can create a folder to store messages that you 

received during 2011. 

 
To create an email folder: 

1. Click Folder tab. 

2. In the New group, click New Folder. 

3. In the Name: field type the folder’s name e.g. Year 2011. 

4. Click OK button. 

 

Note that: 

 The Navigation pane will display the folder created.  
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To delete an email folder: 

1. Select the name of the folder to delete e.g. Year 2011. 

2. Click the Folder tab. 

3. In the Actions group, click Delete Folder.  

 

 
 

4. Click Yes button to confirm that the folder will be deleted. 

 

 

 

Moving Email to Folders 

 
To move an email to a folder: 

1. In the lnbox folder, select the message to move.  

2. In the Home tab, in the Move group, click Move. 

3. Click Other Folder… The Move Items dialog box is displayed. 
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4. In the Move Items dialog box, click the folder name where the message will 

be moved. 

5. Click OK button. 

 

 
 

 

 

Deleting Email 

 
To delete an email: 

1. Choose the message in the Message pane. 

2. In the Home tab, in the Delete group, click Delete.  

 

Note that: 

 Deleted messages are transferred to the Deleted Items folder. 

 

 

 

Restoring Deleted Email 

 
You can restore a deleted message: 

1. Click Deleted Items folder. This will display the list of messages that have 

been deleted. 

2. Choose the message to undelete in the Message pane. 

3. In the Home tab, in the Move group, click Move. 

4. Click Other Folder… The Move Items dialog box is displayed. 

 

 
 

5. In the Move Items dialog box, click the folder name where the message will 

be moved. 
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6. Click OK button. 

 

 
 

 

 

Emptying the Deleted Items Folder 

 

You can delete your mail permanently from the Deleted Items folder as follows:  

1. Click Deleted Items folder. 

2. Click Folder tab. 

3. In the Clean Up group, click Empty Folder.   

 

 
 

4. Click Yes button. 

 

 
Alternatively, you can delete all messages in the Deleted Items folder as follows: 

1. Right-click Deleted Items folder. 

2. Click Empty Folder. 

 

 

 

Adding & Deleting Address Book Contacts 

 

MS Outlook has a built-in address book to store the email addresses and other contact 

details of friends etc. 

 
To open the address book: 

1. Click Home tab. 

2. In the Find group, click Address Book. The Address Book: 

Contacts window is displayed. 
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Note that: 

 The first time you open the address book, it will be empty. 

 

 
To add the details of a friend to the address book: 

1. Repeat steps 1-2 as above. 

2. Click File menu. 

3. Click New Entry… The New Entry dialog box is displayed. 

 

 
 

4. In the Select the entry type: field click New Contact. 

5. Click OK button. 

6. Type the contact details in the form. 
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7. In the Contact tab, in the Actions group, click Save & Close button. 

The Address Book window will display the details of your friend. 

8. Close the Address Book window. 

 

 

To delete the contact details from the address book: 

1. Click Home tab. 

2. In the Find group, click Address Book. The Address Book: 

Contacts window is displayed. 
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3. Choose the contact details to be deleted. 

4. Click File menu. 

5. Click Delete. 

 

 
 

6. Click Yes button to confirm the deletion of contact details. 

7. Close the Address Book window. 

 

 

 

Updating Address Books 

 

You can update an address book from incoming email: 

1. In the lnbox folder, select the required message to add the sender’s email 

address. 

2. Right-click the email address of the sender. 

3. Click Add to Outlook Contacts. The Contact window will be displayed.  

4. Type in any other details as appropriate. 

5. Click Save & Close button. 
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Creating & Updating Mailing Lists 

 

A mailing or distribution list is a group of email addresses collected under one name. 

In MS Outlook, mailing lists are referred to as a contact group. A message sent to a 

contact group goes to all recipients that are listed in the group.  

 

You can create a contact group: 

1. Click Home tab. 

2. In New group, click New Items. 

3. Point to More Items. 
4. Click Contact Group.  

The Untitled – Contact Group window is displayed. 

5. In the Name: field, type the name of the group e.g. My Class. 

 

 
 

6. Click Save & Close button. 

 

 

To update a contact group with members: 

1. Click Home tab. 

2. In the Find group, click Address Book. The Address Book: 

Contacts window is displayed. 
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3. Double-click the name of the group e.g. My Class. The Contact Group window 

is displayed. 

4. In the Contact Group tab, in the Members group, click Add Members. 

 

 
 
Choose the appropriate option: 

Click From Address Book - If you select contacts from your address book 

you can scroll through and add the contacts you want. 
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Click New E-mail Contact - If you want to add a new email contact to your 

group, you’ll just need to enter in their display name and email address then 

click OK. If you want the new member added to your Contacts list then make 

sure Add to Contacts is checked. 

 

5. Click Save & Close button. 

 
Note that: 

 There is no maximum number of names that you can include in a contact 

group. 

 

 
To remove members from a contact group: 

1. Click Home tab. 

2. In the Find group, click Address Book. The Address Book: 

Contacts window is displayed. 

3. Double-click the name of the group e.g. My Class. The Contact Group window 

is displayed. 

 

4. Click the name of the member to delete. 

5. In the Members group, click Remove Member.  

6. Click Save & Close button. 
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To send an email to a contact group: 

1. Click New E-mail.  

2. In the To… field type in the name of the contact group. 

3. Type the subject for your email. 

4. Type the body text. 

5. Click Send button to send the email to all members in your contact group. 

 

 
 
Note that: 

 If you want to make sure you have everyone included in the group, click the 

plus icon to expand the contacts. You will get a dialog box telling you the 

members of the group will be shown and you cannot collapse it again. Check 

the box not to see the message again then click OK. 

 

 
 

 


